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Introduction When I started this project, I never

thought that it would get so intensive.

It all started with my summer job of

'89 when I worked in Florida for

Atlantic Photo Lab running the com

puter room. Ron Constantino was the

owner of the lab and wanted to pro

vide more flexibility to his customers.

He wanted to create slide shows in

which the customer's logos could

appear on each slide. I was hired to aid

in this process. Most of the clients pre

sented me with their logos on poorly

printed business cards. I scanned the

logo and used whatever program nec

essary to make the logo better for

print and slide media, and experi

mented with different scanning soft

ware and found few to be truly

acceptible to my needs. I quickly had

to find fast ways to scan logos and

transform them into postscript format

for high resolution output. I had not

used Adobe Illustrator at all until that

summer, but knew that it was a great

program for the task. Many of the

logos were predominantly type, but

the typeface used was some alteration

of an existing common face. If there

was a case in which I could use a font

that was available on the computer, it

was rendered so poorly on the screen

that I could not work with it. This

meant that printing the artworkmany

times was neccessary to achieve good

results. The introduction ofAdobe's

new ATM (Adobe Type Manager), has

made possible the rendering of fonts

on screen.
LetraStudio from

Letraset is also a useful program but

the fonts were few and limiting. I

quickly learned that if I was to be suc

cessful in drawing logos, I have to

become fast at using the Pen tool in

Illustrator and draw everything that

the logo contained, Fonts and all.

After hours ofworking, I was tracing

many templates and experimenting

with the best way to use the Pen tool.

The end results were better and the

clients walked away with a quality

product.

Summer ended and it was time to

return to school. I wanted to keep up
with my new skill, so I started tracing

complete type faces from specimen

books. I found that I could use these

faces to design my own logos and

headlines. These letters could be

altered, colored, copied, and manipu

lated with precise accuracy. I also

gained knowledge of the typeface that

I was tracing and all its nuances. This

tracing process yielded a typeface that

could be use over and over again. It

also taught me sensitivity to
let-

terspacing, wordspacing, and figure

ground relationships. I wanted to put

all this together in an illustrated

source and training manual, so the

intent of this manual is to teach a new

way to use an existing product, Adobe

Illustrator, to make practical designs

that incorporate hand drawn electron

ic type and graphic elements. With

the methods learned in this book, any



design is possible and only restricted

by your imagination.

Text handling abilities never were

too strong in Illustrator, but the Pen

tool provides the best and most ele

gant drawing sophistication found

with high resolution graphics pro

grams. I wanted the best ofboth

worlds. I wanted to be able to make a

swash on a letter
'S'

in the same pro

gram that I was illustrating elements

for a logo. Downloadable fonts can

never be altered in this manner.

Letters had to be drawn so that the

individual points that make up the

letter could be moved and paths could

be reshaped. I found that the only way

to get the effects that I wanted was to

draw the letters myself.

During the writing of this book

certain products were introduced to

the market that helped solve some of

the problems that I was having.

Adobe created a great program ATM (

Adobe Type Manager) that takes the

printer font information, and renders

the font on the screen at any point

size. This means that huge blocky
type is a thing of the past. The prob

lem with this solution is that you have

to buy the font instead ofdrawing it

yourself, which is very expensive.

Another very significant product is

TypeStyler by Broderbund. This prod

uct is a type altering software that

works very much like LetraStudio.

The TypeStyler s (version 1.01) advan

tage is the ability to convert all Type 1

and Type 3 Adobe fonts. Then it can

export the outline information to

Illustrator. This means that if you

have an Adobe font, you can convert it

to TypeStyler format, then export the

outlines to Illustrator. No tracing is

necessary. To use this method in

TypeStyler you have to export the out

lines to Illustrator and alter them

there. Then you have to save them and

place them back into TypeStyler. This

same font conversion and alteration

ability can be found in the new ver

sion ofLetraStudio. All of these

improvements are great for the user

who wants to get high quality and

flexible designs that take several steps

and different programs to get the

desired results, but these designs come

at the expense of the programs, and

the price of the Adobe fonts that have

to be bought. This manual contains

useful tips that aid the designer in

avoiding buying all of these products.

The proper use of Illustrator can breed

results that can be found in all of these

other products. If you already own

some of these programs and/or fonts

and want to get the best use out of

them, then this manual can help you

use them faster and better.



Overview of

the software

Adobe Illustrator at first glance

seems quite a simple package. The

tool box has relatively few tools

which make the software seem easy

to use, but Illustrator has many hid

den features that make it one of the

best and most elegant Postscript

draw packages today.

I will take you through the

important Menu items and Tools to

get you familiarwith their use, but,

more importantly, I will show you

specific examples of how the tool is

used and what it can do best for spe

cific tasks.

Illustrator hides many dialog
boxes containing powerful features.

The Option key combined with a

click of the mouse on the majority of

the editing tools displays a dialog

box where specific increments or val

ues can be entered. Most Menu items

have keyboard equivalents where the

Command key combined with a key

stroke speed up work and make

changes fast and easy.

Below, we see the "About
Adobe"

window that displays the version,

registration information, and memo

ry usage indicated by arrows.

Penonalised tor.

Brett Sennctt

B*4DgDctigM

"

Adobe
IUustratorSc?"

Mike Schuster, TeriPettit, JohnMaoMfflam,
Sieve Schiller,JohnKance, Bill Pajtton, and

JohnWaraook.

-f Version 1.9.3

Copyright 91987,1988 Adobe Systems Incorpozated.

AH Rights Reserved. Adobe Illustrator 88 and the

Adobe Illustrator Logo are trademarks of Adobe

Systems Incorporated. PANTONE6 andPANTONE*

MATCHING SYSTEM are registered trademaiks ol

Pantone, Inc.

-? 93* bee memory (1403Kbytes).
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New...

Open...

Place...

86N

910

Close

Saue

Save Rs.

MS

Page Set

Print...

up...

S*P

Quit S*Q

|Q Neui Applications |

<5< lldatie Streamline'"

?
Canuas

2.0

? LetraStudio"1
1.0

0> M<|<30

<> MicroMind Player

CD MM Director

Save illustration as:

|My first ill-art

> flock 0 Roll

1 tjecl ]

[ Oriue ]

[ Save ~~]

[ Cancel-]

Include preview for

O None O BlackOUIhite Macintosh^

O IBM PC0 ColorMacintosh*

. Include copy of placed Encapsulated

PostScript files for other applications

JSave Adobe Illustrator I.I compatible file

The Pile menu contains the same

Macintosh features found in most

all other software programs. The

Save option has a variety of

choices that make Illustrator doc

uments accessible to other

Macintosh programs such as

QuarkXPress, Ready Set Go!,

Freehand, and other desktop pub

lishing and presentation pack

ages.

The Include preview section con

tains four options. These options

create screen renderings (Quick

Draw, Macintosh only) for either

a Black & White Macintosh, Color Macintosh, or IBM PC.

If None is selected, then no screen image will appear in other applications.

The Include Encapsulated PostScript option creates the PostScript text file

that other applications need to print the document on a PostScript printer.

Save Adobe Illustrator 1.1 compatible file is for saving the document in the

old Illustrator format for use with the old Illustrator. More importantly,

Freehand will open and convert Illustrator 1.1 files. This means that you can

arrange, draw, design and place elements in Illustrator and then open the

document in Freehand where you can take advantage of Freehand's fill effects

and printing capabilities. The draw tools in Illustrator are much more ele

gant than Freehand's. I tend to draw all my logos and designs in Illustrator

and save them as 1.1 compatible where they can be manipulated colored and

separated in Freehand.

The Place option places other Encapsulated PostScript files into illustrator

to be printed and arranged in drawings and designs you create in Illustrator.
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New...

Open...

Place...

KN

Close

Save

Save Rs.

38S

Page Set

Print...

up...

Quit MQ

tt.WM

Ondo Copy aez

Cut

Copy
Paste

Clear

Select Rll

36H

sec

ma

Paste In Front

Paste In Back

86F

3"B

Bring To Front

Send To Back 36-

Preferences... 3tK

The Page setup option is mainly used to change the page
from a portrait format

to landscape. The type ofChooser output device that you are using will govern

what dialog box that will appear. For a LaserWriter, the dialog will look like

the example below. Simply click the landscape Orientation and the page for

mat will change to the a horizontal format. The Imagewriter has a similar way

to do the same thing. This is also where you can Reduce or Enlarge the entire

document by changing the percentage size. If you enlarge beyond the designat

ed page size, Illustrator tiles the document for you.

LaserWriter Page Setup

Paper US Letter Of" Letter

O US Legal OB5 Letter

Reduce orhggk Printer Effects:

O Tabloid

Enlarge:

Orientation

1

SFont Substitution?

HTeHt Smoothing?

H Graphics Smoothing?

H Faster Bitmap Printing?

[ Cancel ]

[Options]

[ Help |

! Preferences !

[3 Snap to point

S Preuieiv and print patterns

? Transform pattern tiles

HShow placed images

Constrain angle:

Corner radius:

Cursor key distance:

Freehand tolerance:

Ruto trace gap distance:

Split path resolution:

[Change Progressive Colors.7")

Cancel

Ruler units

O Centimeters

O Inches

Picas/Points

The Edit menu sup

plies you with the

familiar Cut, Copy,

Paste, Undo and Select

All. The Paste and

Bring to Front and

Back will be discussed

later in the book. The

Preferences give you a

variety ofoptions to

customize your docu

ment.

Ruler units lets you choose the units ofmeasturement that you want to see in

the document. Constrain angle constrains all drawn boxes and ellipses to the

desired angle. Cursor key distance provides you with the ability to adjust the

distance the cursor moves on the screen when the arrow keys are depressed. The

Freehand tolerance adjusts the number of points placed when using the freehand

tool, while the Auto trace gap distance controls the auto trace tool. The Split

path resolution controls the splitting up of the document for printing on high

resolution Postscript printers.



Transform Rgain 960

Eroup

Ungroup

9CG

Join...

Average...

XJ

XL

Lock

Unlock Rll

Hide

Show All

862

963

964

I Average

-Average along

OBoth aHes

Horizontal aHls only

O vertical aHis only

OK

1 Cancel I

TheArrange menu has a variety of very useful features. The first item is

Transform Again (Command-D). This feature is mostly used to repeat the

move you just made. If you selected a rectangle and moved that rectangle

while holding down the option key this would make a copy of the rectangle.

If you selected Transform Again from the Arrange menu the copied rectangle

would be copied and moved the same distance and angle each time Transform

Again was selected. The Group and Ungroup commands provide you with the

ability to group items so that they work as one. Grouped items can be resized,

moved and duplicated while they are

grouped. The Join and Average com

mands work on points on paths only.

These commands are discussed in

detail in other parts of the book. The

Lock and Hide features are two use

ful tools to aid you when illustra

tions get complicated. The Lock

feature locks selected items so that

they cannot be selected again and

altered in anyway. This tool is useful

when an object on in the illustration needs to be visible for reference but in

turn can not be selected or altered. The Unlock All feature unlocks everything

that was previously locked. The Hide command hides or makes invisible any

selected object or objects in the illustration. This feature is particularly useful

when the illustration gets so busy and confusing. Items can be hidden there

fore clearing up space to work. The Show All command shows all previously

hidden objects. Hidden objects will also not print.

in"
i join ^^^~^~S

n 0K

Corner point

O Smooth point
I Cancel |
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Preview Illustration 96V

Artwork P Template 96E

?Artwork Only 96111

Template Only

Actual Size

Fit In window

96H

96M

Show Rulers 96R

The View menu displays the different modes that Illustrator displays the work

in progress. The Preview Illustration mode is for viewing the illustration as it

would look as close to print quality. Line weights and colors, pattern fills and

masks will show in the Preview Illustration mode. The next mode is the

Artwork & Template mode. This mode is used when a template is opened for

tracing. The template is displayed with all the artwork that you have created.

The Artwork Only mode hides the template so that you can view your artwork

without the confusion of the template getting in the way. If you want to only

see what the template looks like, then the Template Only mode is to be used.

The Actual Size displays the contents of the illustration in the window to the

actual size they would be when printed. Fit inWindow displays the full illus

tration work area into the active window. Show Rulers displays the rulers to

the settings that you prefer in the preferences dialog box.
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Paint...

Type... 96T

Pattern...

Custom Color..

The Style menu gives you access to the two main editing features. Objects are

drawn in Illustrator, but they all have some form of paint values or character

istics associated with them. They could be outlined red with a pattern fill, or

black outline with no fill. All of these characteristics are entered with the

Paint feature. The Dialog box appears where all of the elements below can be

applied to one or more selected items. All of the Paint features will be dis

cussed in detail with useful examples later in the book.

Paint !

.-Fill .

O Process Color

O Custom Color

Pattern

O

ITransform... I

r-Stroke

ONone

OWhite

Black

O Process Color

O Custom Color

O Pattern

Black: 100 %

? Overprint

?Mask

U)elght:|3 | pt I Cancel |

Mller

limit:

.-Caps 1 i-Joins 1

O Q o
at ( o %>

or^ o -^

Flatness: |o | piHels

Note:

Dash pattern -

O Solid

Square w/ rounded

corners and dashed

lines

Dashed: 1 5 Pt

The Type menu item allows you to enter text to your illustrations. All of the

text you enter can be painted exactly as the drawn elements. Alignment, Font,

Size, Leading and Spacing can be applied within this dialog box.

i Type :

Helvetica-Black

Helvetica-BlackOblique

Helvetica-Bold

| Cancel"]

Size: I42 1
Leading: I48 1
Spacing: 1" 1
This dialog box is for entering teHt!
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Paint...

Type...

961

SIT

Pattern...

Custom Color...

The Pattern command is discussed in detail in a later chapter. Its powers are

numerous and applications are many. There can be many different patterns in one

illustration. Each pattern has a different name to differentiate between them.

Pattern i

[Cancel |

~Neu< i

I Oelete I

(~Paste~|

I Select HII Unused |

Change name to:

New Pattern I

The Custom Color feature is useful to determine the Pantone to process colors

conversion. If you were using the Pantone Color page included with your

Illustrator package, the process color percentages that it takes to makeup that

color are displayed within the Custom Color dialog box.

Custom Color I

Hi PANTONE 542 CV o
PANTONE 543 CV

PANTONE 544 CV '!

PANTONE 545 CV .;."[

i PANTONE 546 CV

"PANTONE 547 CV

"* PANTONE 548 CV
,v!t

SfK PANTONE 549 CV

PANTONE 550 CV $
Change name to

13



The Tool Box

gPi) The Tool Box is the most intimidating interface because most people have lit

tle idea what some of these tools do or stand for.

The simplest and first tool is the Arrow or Selection tool. This tool is used to

select and move objects. When other tools are selected, this tool can be

obtained by holding down the Command key.

rJ3

O

I work with my right hand on the mouse and my left hand on the keyboard.

My thumb is ready to press the Command key while my index finger is ready to

press the option key. My middle finger is also ready to press the Shift key. All

three of these keys are sometimes use together. This speeds up my work time by

at least a third.

7* The Hand tool lets you scroll or push the page around. This tool can be

obtained at any time by pressing the Space Bar.

Q^ The Magnifying Glass tool is for zooming in and out of your work. To zoom

in you simply click the mouse within the illustration area with this tool

selected. To zoom out, you click the mouse with the Option key depressed.

When the Option key is depressed, the Plus sign in the Magnifying Glass

tool will change to Minus.

X The Text tool lets you put text into your illustrations.

'._./> This tool is the Freehand tool. This tool enables you to click and drag the

mouse around the screen. The path you take will be drawn on the screen.

(pi/ This is the Autotrace tool. This tool is use to automatically trace templates

open in Illustrator.

A The Pen tool is perhaps the single most elegant drawing tool of any computer

package. The Pen tool is use to draw straight lines (paths or strokes) and

curves (Bezier curves). These paths and curves are all mathematical forms and

can be altered to your heart's content.

14
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The Rectangle tool draws rectangles. It can also draw perfect squares by hold

ing the Shift key while dragging the mouse. Rectangles can be created from

the center out instead of corner down simply be depressing the Option key
while drawing rectangles. The combination of Shift and Option key will draw

perfect squares from the center out. Squares and rectangles can also be placed

in accurate size by clicking the mouse on the work area with the Rectangle

tool. A dialog box will appear where increments can be entered. A rectangle's

corner radius can also be entered with this dialog box.

IQggg^^^s Rectangle ^^^^^^^=

Width: |340 Pt

Pt

Pt

oo
Height: 1 260

Corner radius: [20

[ Cancel |

q The same features as the Rectangle tool can be found with the Ellipse tool.

ID^H Oval ^B

Width:

Height:

1 OK ]|500 | Pt

200 | Pt [ Cancel |
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The Blend tool is use to blend two shapes in a number of steps that you specify.

The Blend tool will be explained in further detail later in the book.

,E3

! Blend

Number of steps: |l

First blend: 150

Last blend: I SO

The Scale tool is use to scale objects. The Scale tool works by selecting an object

and clicking to establish a center ofscalepoint, then you drag the mouse to

enlarge, shrink, or stretch the object on the screen. To obtain the dialog box,
select the object you wish to scale and click the mouse with the scale tool while

depressing the Option key to establish a center ofscale point. The dialog box lets

you enter the mathematical scale factors.

in^HII^^^^^ Scale S^^^^^^^S

fiE-JUniform scale: 1 200 |%

Preserve line weights

O Scale line weights

| Cancel |

1 Copg |

o Non-uniform scale:

Horizontal; 1 ! %

"eillcal: \ \%

"J, The Rotate tool works exactly like the Scale tool. The center of rotation is

established by where you click the mouse. The dialog box is activated by hold

ing the Option key while clicking the mouse.

iassi~^B Rotate !

Angle: rwnI20 1
"

I Cancel |

1 Copg |
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,'j^ The Reflection tool mirrors anything across any axis. The tool works simular to

the Rotate tool. The Option key and a click displays the dialog box.

Reflect !

-Reflect across ,

OHorizontal aHis

O Uertical aids

RngledoKis: J4S |

I Cancel |

I Copu I

The Shear tool slants objects to any degree or axis that you desire. The Option key
and a click of the mouse like all the other tools displays the dialog box.

Rngle: 1 1 0

r-Sheer along

O Horizontal aHis

O Uertical aids

Rngled aHis: 1 25

| Cancel"|

I Copy |

Q Shear pattern tiles

> The Scissors tool cuts paths into two separate sections. Simply select the Scissors

tool and click somewhere on a path, but not on the end of a path, or aWarning

message will appear. To add a point to a path, depress the Option key while click

ing on a path. This adds a point to the path.

' ! This tool is theMeasurement tool which gives precise measurements of your doc

uments. To activate the dialog box, select the tool and click the mouse on a start

point and stop point. The distance, angle, horizontal and vertical differences

between the two points is displayed.

ID^^S Measure

Distance: 602.0797 pt | OK 1
Rngle: -48.37

"

Horizontal: 400 pt

Uertical: -450 Pt

The Page tool moves the specified page around to accommodate the illustration.

17



Scanning
Type using

HyperScan

The general rule of thumb is that

the better the scan, the easier iot is

to trace, so after doing large

amounts of scanning using various

scanners, I found that the best

results in reproducing type for tem

plates to trace is HyperScan using

the Apple scanner. HyperScan is

scanning software that scans 72 dots

per inch into HyperCard windows.

HyperScan is a stack that was writ

ten by Bill Atkinson, the author of

MacPaint and HyperCard. The stack

has an excellent help section that

guides the user through the paces of

scanning. If you are a comfortable

HyperCard user then the interface

will be quick to understand making

it possible to get great results from

the very first scan. To the casual

user, the interface is simple and

friendly. Since Adobe Illustrator

only uses MacPaint and PICT for

mats as templates, the simplest scans

create the best workable templates.

HyperScan creates very workable

templates to trace. HyperScan

enables the user to control the

brightness and contrast just by mov

ing the mouse from side to side and

up and down. I chose HyperScan to

do the scanning because of the ease

of use, quickness, halftone ability,

and the quality of the templates that

HyperScan produces.

xjB

'

Gilbert Fred GomenHyperScan ^^^^^^^m

. .... . ,i ".. ,. .. ............
-i....i,...i

i|;l[| jiiii; !-!:=lj|lii|[||!|j&!ijijijijj!jji]Mi1lll||||f[Hill nUlll|l|llMljliJjl|lll|lfsii|11lll!l|lll|l|=M--5:iMI|l|lllllIsi:-=; s|ll?sl=HHlPl|lr^1=1^ lilll= llllU^iiijljlilii!

Vp'

!','W7bj7

Welcome to
HyperScan

by Bill Atkinson

,jlfSPipls^iiiisf

* Ji

Copyright 1 988 Apple Conr-puter, he.

=^-i l-l--? ! !$!1ill-Hiij iiiii!Ijlll!Iii!
'

i i
:

"i 'M
!,;,;; "W'T

'

Tl
Q- SHE]

i i



Since HyperScan is a HyperCard

stack, the help section is interactive

and easily accessible. The topics

offered are explained in the On-

Line Help section.

Gilbert Fred GomerHyperScan !

I

HyperScan On-Line Help Menu

Setting up yourApple Scanner

Walking through your first scan

Getting around in HyperScan

The Portrait and Landscape cards

The Halftone card

The Effects card

Shortcuts

Advanced commands

Select a topic by clicking it

A quick breakdown ofHyperScan's

operation shows the first card. The

buttons on the bottom take you to

the different sections of the stack.

The first button is the Help sec

tion. The next button is the

Portrait mode. This is for scanning

objects that are tall in orientation.

This is the most used mode. The

next button is the Landscape

mode. The next two buttons are

for image manipulation. The first

button with the cross hair is for

applying halftone effects. The next

button is the effects picker. The

last button takes you to the stack of

HyperScan examples.

iiiiii

Gilbert Fred GomenHyperScan I

w^mmm llSlllllllKW

'..v :

Welcome to
HyperScan71

by BillAtkinson

-ASS

CopjrigM 1 986 AppV Computer, ho.

i-rv
-

o\

w
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Gilbert Fred 6omenHyperScan !
,.............^.

...........^..^.........^....^
I

"^"rr;*"?.-
-

^.^i.-f;+...:ri<-"v:ii ,
:-

.
Tm.^*p.:: :. k'ii^ii: : :.

"

U"iO.*Ht:wjli:<.x|*t^i.iiu.:t.'-^',iv^ ::

^H^tty,,^-il^i:Wrxtca

iwjsyzss-."

Vi? 0)^il||i,L\i\rjt<;!b-n \
LvCYvfrf'

1_lr>H>fflS

;ii!i!i;i!ii.:ii!li!j!ii

r?innFiiss

To get to the card shown here, click

on the Portrait button. Place a type

sheet out of a specimen book. The

best results are to scan the largest

point size in a sample book. Click on

the Preview button. The Scanner will

quickly scan the entire
page and dis

play the results into the
scanner win

dow. The rectangle you see represents

the Hyperscan window. It cannot be

stretched out ofproportion, but can

be resized. The smaller the rectangle,

the bigger the letters will appear in

the Hyperscan window.
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As we see above, the entire typeface

was scanned in one pass. The results

of that scan are shown in Illustrator

as an opened template. The two

views show that the letters are too

choppy and difficult to trace.
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The rectangle can be resized to

zoom into the typeface. When the

rectangle is resized to the smallest

size, the template or typeface is

much larger and smoother.
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The example to the right shows the

template result of the above scan.

We see that the template is much

better and easier to trace.
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These side by side comparisons show

the difference and the importance of

good scans.

Untitled art 2:badn scan Di Untitled art 4:better tempEl

T

?

o

KH

a

>!<

II

D

iiiii

aa aaaaa

a a
a

SB
a

a a

SB "1 i
aa aaa a a

aaa a

aana aaa

U
1 Bai

iaa
BB
aa

M
o
5EF5 mQ

22



Now that we have covered the

importance ofgood scans, let's go

through scanning adjusting, and

saving a typeface for templates to

trace in Illustrator. Find a good

clean copy of a typeface to scan. I

will scan Garamond, but you can

scan any typeface you choose. Place

it on the scanner face down and go

to the Portrait mode to scan.

Preview the page. Resize the

HyperCard rectangle to get the

smallest rectangle while maintain

ing ascenders and descenders.
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After scanning the section of type,

you will be transported to this win

dow where HyperScan's power and

ease of use shines. The section will

be presented in this window for fine

tuning. The crossbar cursor is the

controller of the brightness and con

trast. Move it and down, left and

right to get different settings.
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The Halftone card (continued)

Moving the crossbar
to the left decreases the

contrast; moving
It right increases

the contrast. j-^<^a?.'i\'w

Moving the ,. *&

crossbar up
increases the

brightness; Less contrast

moving it down

decreases the brightness.

More on next card

Help Menu
B-

This window is the explanation of

the process. Help can be accessed by

clicking on the Question mark icon.

This example looks a little to

light so we will adjust it further

by dragging the cursor down.

The scan should get darker.

fflODHi
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We can see that this is too dark.

Move the cursor more toward the

middle of the window.

Now that we have acquired the

desired settings, all we have to do is

click the save button. This saves the

image to a card and places it on the

end or back of the HyperScan stack.
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To scan more of the face, we need

to go back to the vertical window.

Click the second button for the ver

tical scan window to appear.

Now without resizing the rectan

gle, move it to an area not yet

scanned. If the rectangle is resized,

the letters will not be the same size.

Repeat the process of scanning

adjusting and saving. The
page does

not have to be previewed again.

This process may seem tedious, but

the templates we are making are

detailed and easy to trace.
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If an object is mounted on a page

horizontally, it can be placed on the

scanner and scanned using the hori

zontal window.
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HyperScan gives you the chance to

add halftone effects to your scans.

The window in the example is

accessed by the far right button.

! Gilbert Fred Gomer.HyperScan I

Halftone Effect: Diffusion

MWWHffl

snnQi

!;:,

The help screen explains the process

and effects of applying halftone

effects to your scans.

Gilbert Fred GomerHyperScan 1

The Effects card

The Effects card has 30 halftone effects. Clicking a square applies

the halftone effect to your scanned image. The name of the effect

currently applied to the image appears above the squares.

In general, the

Diffusion effect -

produces the

best results, even

for line art and

other high-

contrast originals.

The other effects

can be used for

different artistic

variations.
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Help Menu

tt
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Now that we have the complete

face scanned, we need to make a

MacPaint file out of it. As it is now,

we can not open it as a template in

Illustrator. To make aMacPaint file,

we must Export it as paint.
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New Stack...

Open Stack... 880

Save a Copy-

Compact Stack

Protect Stack...

Delete Stack...

Page Setup...

Print Card

Print Stack...

Print Report...

Quit HyperCard 860
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New Stack...

Open Stack... 360

Save a Copy...

Import Paint...

i.i.ijaj-.ii
"

Compact Stack

Protect Slock...

Delete St<k...

Page Setup,..

Print Card

Print S1a<k...

print Report...

Quit HyperCard 3611

The menus in HyperCard change

when in different modes. When in

browse mode, the File menu appears

as shown on the far left. However,

when in painting mode, the File

menu changes to display the Import

and Export paint options. Simply

click on any painting tool in
the

HyperCard toolbox and go to the File

menu. Select Export Paint..., this dis

plays a dialog box to save aMacPaint

file that can now be used as a tem

plate. Go to the next card by depress

ing the right arrow on the keyboard

or by selecting Go Next from the Go

menu. Repeat the process until all of

the scans are saved to disk.
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You may have noticed that the

typeface is now broken into many

different MacPaint files. When I

save the MacPaint files from

HyperScan, I give them sequential

names so that when I trace the

typeface, the templates can be

traced in some logical order. The

method I use to put together a

complete face is to open the first

template and trace all the letters I

see. Then I save the illustration

with the name of the typeface.

Without closing the window, I

start a new illustration using the

next scan as a template. Trace the

letters there, copy them, and paste

them into the first window. Save

the changes to the illustration.

Keep repeating this process until

the entire face is traced and saved.
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Tracing
the letters

Letterforms are wonderful shapes when

we look at them as shapes and not just

letters. With Adobe Illustrator, you

can trace any form with practice.

Letter-forms are great practice and you

get the benefits ofa workable letter or

complete typeface when you are done.

Practice makes perfect, so practice

often and the skill learned from this

book will come easier and more under

standable. You will soon find the

Bdzier pen tool ofgreat use to you, and

it will be your best weapon to design

with.

The examples chosen to demon

strate tracing get progressively harder

as we go along. Helvetica is a san-serif

face that does not require that much

skill to trace. We will start with

Helvetica and progress to Garamond.

These two typefaces are very familiar

to designers making their forms more

recognizable. Helvetica can be traced

in less time than serif faces, but there

are some additional short cuts that are

dis-cussed in this section that are use

ful. To start, we will create a new illus

tration and select the scanned

Helvetica as the template to work

with. We will start with the simplest

letters. Find the letters 'H\ T, and 'J'.

These will be the letters we will start

with. Zoom in to the letters so that we

can begin.
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The Helvetica letter T is the easiest

letter to draw. Since the letter is

simply a vertical rectangle, we will

use the Rectangle tool to draw it.

Select the Rectangle tool and posi

tion it on the corner of the letter.

Click and drag over the template

until the template is surrounded by
the lines. If you find that what you

get is undesirable, go to the Edit

menu, Undo and try again. It is

always easier and faster to use the

Rectangle and Ellipse tools to draw

those geometric shapes.
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For the
'H'

we will use the Pen tool

to trace around the letter. The short

est distance between two points is a

straight line and that is what we get

by simply clicking the mouse from

point to point or corner to corner on

the template. To aid us with the

horizontal and vertical alignments,

we will hold down the Shift key.

This places a point directly horizon

tally or vertically from the previous

point.
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Continue around the letter while

holding down the Shift key. You do

not have to be accurate because we

will adjust and align the points once

all of the letter is completed.

Finish the letter by clicking the last

point on top of the starting point to

complete the path. Once the letter is

complete we can align the points.

Notice that the points are not at all

aligned in the illustration to the left.

Abobe Illustrator provides an easy

way to align the points.
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Select all of the points on the upper

sections of the
'H'

and T. We will

align them on the horizontal axis.
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To align the points on the horizontal

axis, choose Average from the

Arrange menu or type Command-L.

Transform Again 9~D

Group

Ungroup

KG

XU

Join...

Average. ..

XJ

XL

Lock

Unlock All

Hide

Show Rll

XI

X2

x^

X4
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If you get the result that you see

in the illustration, it is because

the letter T consisted of grouped

points. Simply Undo the move

and Ungroup the letter T. Repeat

the procedure and the you should

get aligned points.
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Select the vertical points to vertically

align them. Type Command-L for

the dialog box. The process is the

same for vertical and horizontal

alignment.
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Make sure that you select the verti

cal alignment. Click OK and the

alignment is complete. Continue

around the letter until the points are

all aligned.
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Previewing the results shows that

the shapes are perfect letter forms.
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Straight lines combined with curves

are almost as easy as plain straight

paths. We will use the
'J'

as an exam

ple. Start at the top and follow around

clockwise as in the example. Click the

mouse where the curve starts to form

and drag the mouse about half the

distance down to the next point with

the Shift key depressed.
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Click on the farthest point south of

the letter and drag, with the Shift-

key down, to the left. The curve

should look like a section of an

ungrouped circle.
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Click on the left most point and drag
up until the curve fits the template.
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Click directly on top of the point

you just put down. This will stop

the curve. From a curve line to a

straight line transition, you need to

click again directly on top of the

point and then click for the next

point. This breaks the other curve-to

handle creating a curve to straight

line corner point transition.
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To create a straight line to curve line,

click on the point you just placed

and drag the handle down using the

Shift key. This creates the straight

line to curve transition needed for

the next point.
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Click on the next point and drag up.

If you are following the process and

placing the points as you see in the

examples, the curves will always

match the template.
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Finish the form by clicking on the
original point. Notice that in the

example, the points are not in line.

We need to adjust these points.
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Use the Command key to convert to

the Arrow cursor to select the points

that are out ofalignment and type

Command-L. Choose the Vertical

axis only and the points will align on

the vertical axis.
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In the Preview mode, we see that the

letters look nice enough to use for

logos, headlines, ligatures and what

ever your imagination can comeup

with.

Try to trace the rest of the alpha

bet for yourself. Remember to use the

Shift key. Each technique we used can

be applied to tracing any typeface,

shape or form. Practice makes perfect.

You should be able to master the Pen

tool and with it do the work in min

utes that took houts before.

The best results with the Pen tool

can easily be obtained using the

method described below. The key to

the Pen tool is to use it with the Shift

key held down. Using the Pen tool

with the Shift key creates perpendic

ular tangents to a curve.

Open the scanned Garamond
's'
and

zoom in. Find the upper most tip of

the
's'
and hold down the Shift key

while dragging the mouse to the

right. You will see curve-to handles

that are horizontal.
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On this letter we will try some

variations to achieve the best

results. Position the cursor on the

tip of the next area. Observe where

the next point we will use in the

example to the left. Click and drag
down to the right. Do not hold the

Shift key because the we want to
set up a smooth transition curve to

the next point. By following the
example we will see the results will

be desirable. The best way to find

out where to place the next point

and where to drag the mouse sim

ply takes practice.
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Click the mouse at the tip of the

curve of the 's'. Hold down the

Shift key and drag slightly to the

left. We see that the curve should

bow out to fit the template.
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By setting up the previous point,

the next point and curve should be

as simple as clicking the mouse at

the upper point of the template and

holding the Shift key down while

dragging the mouse to the left and

watching the curve fit exactly
into

position.
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The same process is repeated for the

next point. The only difference is

that we will be dragging the mouse

down instead of to the left. Once

again the curve should fall directly
into place.
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Place the next point on the far right

point on the
's'
curve. Drag the

mouse down with the Shift key.

Follow the example to see the

desired effect. The curve can always

be adjusted after the initial points

are placed. There is no need to try

making the curve fit at the time of

putting the points down.
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Depress the command key to trans

form the Pen tool into the Arrow

cursor. Select the curve-to handle

and drag the handle up. At the same

time you drag, depress the Shift key
to keep the handle on the vertical

axis. This maneuver requires that

both the Shift key and the

Command key are depressed at the

same time. In many moves similar

to this, a combination of key strokes

and mouse clicks are used. I tend to

use my thumb for the Command

key and my index finger for the

Shift key. What ever is most com

fortable for you should be used. In

any case, a two-handed Mac user

will always work faster than a

mouse-only user.
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Once the curve is adjusted on one

end, the other handle must be

adjusted to make the curve match

the template. Select the other point

and drag down with the Shift key.

The curve should start to fit the tem

plate. Keep adjusting until the curve

fits.
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Like the top, we will place a point on

the farthest tip south and drag to the

left with the Shift key keeping an eye

on the curve to see when it matches

the template.
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Place the next point as shown in the

example and drag the mouse up
with the Shift key depressed until
the template is matched.

Hold the Shift key down and click

the next point. The Shift key will

keep the point on the same axis.

Drag the mouse up slightly up with

the Shift key still depressed. The

purpose ofdragging the handles up
is to set up the next curve. If you

had simply clicked the mouse, then

that would have made a simple

anchor point where smooth curves

are desired.
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Click the mouse on the next point

and drag the mouse along the direc

tion of the template, the serif of the

V should form and the curves

should match the template.
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Continue to the next point and

repeat the same process.
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Like the opposite side of the V, we

will perform the exact same motions.

Follow the illustrations to see where

to click and how far to drag the

mouse. Remember to hold the Shift

key down when dragging the handles.

Click on the next point (farthest to

the left) and repeat the process.

Remember that you do not have to

make the curve fit the template in

one move. Adjustments can always

be made later.
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Adjust the handles until the curve

fits the template.
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Click the mouse directly on top of

the first point. Drag the mouse with

the Shift key until there is enough

curve to work with. Make sure you

drag the mouse to the right. While

dragging the cursor to the right, you

will see a curve-to handle grow to

the left. We need that handle to

adjust the curve later.
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Use the Command key to select the
curve and drag it into place. If the
previous move was completed cor

rectly, then pulling the curve

into position should be as simple as

dragging the curve slightly down.

Once complete, we can view the

artwork without the template.

Depress the Command-w keys or

select ArtworkOnly from the View

menu to see the curves with no tem

plate getting in the way.
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When we select Preview Illustration

from the View menu, or type

Command-y we should see a nice

ready-to-use Garamond 's'.

Now we will advance to a much

more challenging letter form. The

Garamond lowercase
'g'

has an V

shape to it. It also has two counters

that need to be dealt with. Locate the

'g'
and position it on the screen to

begin tracing.
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Find the upper point of the letter 'g'

shape as we did with the letter 's',

hold the Shift key down and drag
the mouse to the right.

Click the mouse at the next point of

the 'g'. Drag to the right with the

Shift key held down. The farther

you drag the mouse to the right, the

more the curve can be adjusted.

With the Shift held down, move the

mouse back and forth until the

curve matches the template.
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To get the next point horizontally

across from the previous point, we

turn to the Shift key again. Before

clicking the next point,
hold down

the Shift key first. You do not have

to be precise about where you click

the mouse. The Shift key will con

strain the next point placing it only

on the horizontal axis across from the

previous one. Keep the Shift key

down and drag the mouse slightly

to the right.

Go the the next area with no key

board keys depressed and click and

hold the mouse. Once the point has

been established, pull the mouse to

the left while depressing the Shift

key. This creates the arch that the

serif requires.
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Use the Shift key again to establish
the next point. This time we only

want a simple click. This will cre

ate an anchor point with no curve-

to handles.
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The next step will show the power

ofusing the Shift key. Find the far

thest point to the right of the curve.

Click the mouse at the point then

depress the Shift key and drag the

mouse down. The more you pull the

mouse down, the more the curve

curves or arches. You will see the

curve match the template exactly.
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The next point on the
'g'

and which

is indicated in the example to the

left. Click the mouse and then press

the Shift key. Drag to the left. Drag

only as far as the
example shows. The

curve falls short ofmatching the

template, but there is a quick way to

adjust the curve to match exactly.
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Select the arrow cursor from the tool

box or hold down the Command key

(this temporally converts the pen

tool to the arrow cursor as we see in

the example) and click on the curve.

Illustrator gives the user the ability

to grab a curve and adjust it. Pull the

curve into place and an exact match

to the template should occur.
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Choose the pen tool again and con

tinue to the next point on the 'g'. If

the path is broken (the path does

not continue to the next mouse

click), then click on the last point

established and drag the mouse to

the left with the Shift key down.

Sometimes when you change the

pen tool to the arrow cursor, there is

a tendency to click the mouse on

the screen any where. If this hap
pens the path stops and the Pen tool

thinks it is starting a new path

instead of continuing the previous

path. Click to the next point and

drag down until the path matches

the template.

Continue to the next point on the

'g'. At the top of the descender,

click and drag with the shift key
down. We see that the curve does

not match the template, so we will

adjust for that.
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Once again we need to switch tools.

Hold down the Command key to

convert the cursor to the arrow (I

find using keyboard commands and

short cuts to speeds up work tremen

dously). Select the curve-to point and

pull down on it. Hold down the Shift

key at the same time so that the

curve-to points stay on the vertical

axis. The curve should fall right into

place.

Find the right most place on the

descender and click, depress the Shift

key, and drag down. The curve

should stretch into place.
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Find the lowest point and repeat the

same process as shown. Remember

that at anytime you miss place a

point or do anything wrong by mis

take, simply Undo the move and

continue.

When establishing a curve to fit the

template by dragging the mouse out

far to the left, curves can be over

extended. The example shows how

the curve over extends the template.

Continue as though the curve

matches exactly and simply go

back and adjust.
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Hf Using the Command key, move the

curve in place to match the template.

EI Continue to the next point with a

Q, simple click establishing an anchor

point. If the previous curve-to handle

was dragged to the correct position,

then the curve should match the

template with no adjustments.
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Continue to the farthest point to the

left and repeat the process.

The next point should be placed as

in the example and the process

should be repeated. The curves

should be falling into place.
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Continue on around the
'g'

remem

bering to use the Shift key.

To finish the path, click on the start

ing point and drag the mouse

(with the Shift key down) to the

right until the curve matches the

template. If you miss the starting

point, simply Undo and attempt the

curve again. Just position the cursor

directly over the point and click. If

you noticed, we are drawing the out

side of the 'g'. The letter will consist

of three parts. The outside, counter

and the lower counter of the descen

der will all be separate shapes.
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To draw the counter, use the ellipse

tool. Visually find the center of the

counter and with the Option key
down (this draws the ellipse from

the center) drag the mouse until

the ellipse matches as close as pos

sible to the template. This may take

a few attempts, but just undo the

mistakes. Only practice will yield

better results.

Garamond has a backwards slant or

stress. We need to rotate the ellipse

to match the stress. Use the rotate

tool to rotate the ellipse. Click in

the center of the ellipse. Then click

the mouse at the top of the ellipse

and drag to the left. The line in the

example shows the angle of rotation

from vertical. After the rotation is

complete, select the ellipse and

ungroup it for later purposes.
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Now we need to work on the

counter of the descender. In the

example, we went clockwise
around

the outside of the letter. For the

inside of the counter we will go

counterclockwise to show that

either approach is possible, use

whatever direction you are more

comfortable with.

Click once to establish the first

point. Find the next point and

repeat the Shift key process.

Continue around the shape.
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If you are using the Shift key and

finding the farthest points out on

the shapes, then the curves will

always fall into place.

To end the path in the counter, click

the mouse on the first point and

drag up, to the left at about a 45

degree angle. Follow the example to

the right to get an understanding of

what is happening. We see that the

curve does not match the template.

We need to adjust for this.
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Once again we depress the

Command key to convert to the

arrow cursor. Click and drag up the

handle with the Shift key. The curve

should match the template. The

previous curve point handles created

a tension that made the sloping

effect needed to match the template.

Practicing with the Bezier pen tool

will make predicting the placement

of points easier.

Ifwe were to Preview the illustra

tion, the result might look like the

example. What we have here is three

shapes stacked on top of one another

all painted the same color.
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Select the two counters and choose

Paint from the Style menu. Select a

Fill of White and None for Stroke.

The Preview should look like the

example to the right.

One important thing to remem

ber is to always draw the outside of

the letter first. The counters should

be drawn next. Illustrator always

puts newly created items on top of

previously created items. If the

counter was drawn first, the outside

letter shape would cover the counter

and correct rendering would not be

achieved. Also notice that there are

three separate shapes all stacked on

top of each other.
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Composing
a Logo

Designing logos is the main pur

pose behind tracing typefaces. Once

the typeface is in this form, it can be

used over and over again. Letters can

be reshaped, resized and altered.

Logos can be created more easily

using these traced letters than tradi

tional hand lettering. Each logo you

design is ready for client approval.

Once the client approves the design,
the output is as simple as a push of a

button.

In this section, I will take you

through the construction of the AG

logo. The emphasis here is on the

construction of the logo, not the

design. Any two or more letterform

combinations can be put together

using the same technique In this

case the logo consists of two type

faces. The 'A' is Anzeigen, and the

'g'
is Chesterfield. In this section we

will cover copying shapes, painting

them, cutting & merging shapes,

and creating patterns.

The first step is to create a new

illustration by selecting New from

the File menu, or typing
Command-

N from the keyboard. No template

is needed, so click None.

The next thing we want is the

Anzeigen 'A'. Open (Command-O)
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the Anzeigen typeface and select the

capitol
'A'

by dragging the cursor

over the letter while holding down

the Option key. This selects the

entire letter, paths and anchor

points. Make sure the entire letter is

selected. Do not forget the Option

key or only sections of the letter will

be copied to the clipboard. Type

Command-c or select Copy from the

Edit menu.

Show Clipboard

Hide ToolboH

New Window

v'Rnzeigen

mmnmrnum

Go to theWindow menu and select

theUntilted window. This brings

theUntitled window to the front.

Type Command-V or select Paste

from the Edit menu. If only parts of

the
'A'

appear simply delete what

does appear and repeat the process.
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The advantage ofoutlined fonts is

that we can selectively choose what

we want or do not want to show. In

this case we want to delete the

counter of the 'A', so simply select it

and delete.

Select the shape now so that we can

paint it black. The paint menu is

activated by typing Command-I or

by selecting Paint from the Style

menu. Give the shape a Fill of black

at 100%. We do not want any out

line, so select None for Stroke and

click OK. Another shortcut is to

press the Enter key from the number

keypadto OK. This process is quicker

than moving the mouse around on

the screen.
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Let's see what we have so far by typ

ing Command-Y or by selecting
Preview Illustration from the View

menu. We see that the shape is a

solid black with no stroke. is*
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Now we want to expand the shape

wider than it is now. There are two

ways to do this; visually or mathe

matically. The scale tool used by
itselfon a selected item will scale an

object by clicking and dragging.

Combining the Shift key will scale

the item only horizontally, vertical

ly, or proportionally, depending
upon what direction you start drag
ging. In this case we are going to

combine the scale with the Option

key. This accesses the dialog box for

entering scale percentages. Click the

mouse in the center of the shape.

(Where you click sets up the origin

point for the scale.) The scale dialog
box appears where we will enter a

Horizontal scale of 150%. Click OK

and the scale is complete.
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After the scale is accomplished, we

should check the progress. I often

check the Preview Illustration to get

an accurate account of how the logo

is turning out. The
Artwork mode

will not represent the illustration as

well as the Preview mode will. We

see that the
'A'

shape is desirable.

Now the next step is to get
the

Chesterfield lowercase 'g'. Select

Open or Command-O and locate

Chesterfield. OK that choice and

Chesterfield will appear as the

active window.
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Locate the lowercase 'g' by using the

hand tool to push the page around.

Zoom to a comfortable size to select

the letter. With the Option key

depressed, drag over an area of the

letter. If you accidently move the

letter, then type Command-Z or

choose Undo from the Edit window.

Once selected, copy the selection to

the clipboard. Once again make sure

all of the letter was selected or only

parts of it will be copied to memory.

Show Clipboard

Hide ToolboH

New Window

Anzeigen

?Chesterfield

wEsmEm

JOIlKE Chesterfield !

^J 17 Y1VJ A\

Switch back to theUntitled window

to continue working by the way of

theWindow menu. Once the unti

tled window appears, paste the letter

into the illustration. Ifonly parts of

it show up, delete what appeared and

repeat the process. When pasting

objects from window to window, the

shape retains its original size.

However, Illustrator pastes the object

in the center of the window so you

may need to drag it into position. In

this case, the letter should appear as

in the illustration to the right.

is*

to
CD

O

3

CV

ii\

cry

=-

M

n

m a

71



Untitled art

I Paint i

Fill

ONone

White

O Black

O Process Color

O Custom Color

O Pattern

? Overprint

j-0a*h pattern

j * Solid

Stroke

None

OWhite

O Black

O Process Color

O Custom Color

O Pattern

?Mask

Uialgh1:[
Mltei r

limit: I-

I pt | Cancel |

r C-apt

X

-Joins

Flatness: |o | plHels

Note:

Icpllli

D flashed:

EST

Make sure the letter
'g'

is selected,

and choose Paint (Command-I) from

the Style menu. Paint the letter with

White and give it no stroke, then

click OK.
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Preview the illustration to see how it

is developing. The example to the

left seems to be missing the counter

of the 'g', but what happened is it

was also painted white. Illustrator

gives you the ability select and
paint

multiple items.
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To adjust for the error, go back to

Artwork mode (Command-w) and

select just the counter and paint it

black. The previewed result should

match the example to the right.

Move the
'g'

so that the screen

matches the example to the right.

The top and bottom of the
'g'

should protrude beyond the lines of

the 'A'. If you were to preview the

illustration now, you might think it

was finished, but there is more

refining to be completed.

EE EH ?aa
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Move the shape here.

Click here first.

SI

Now we ate going to skew or slant

the letter to the left. The line in the

example is to show how far off verti

cal the letter should be moved.

Notice the markers within the exam

ple. Click the mouse where the

example indicates, then with the

Shift key depressed click at the top of

the letter and drag the mouse to the

left. The Shift key constrains the

slant to a horizontal movement. (The

vertical axis is slanted while main

taining the horizontal axis.)

The next few steps will show the

power of the outlined letters. In the

example we see the numbers 1,2, and

3. These numbers designate the three

different sections we want to create.

To explain further we have three

shapes: the Anzeigen 'A1, the

Chesterfield 'g', and the counter of

the 'g'. Each shape is on top of the

other. We want to create new shapes

indicated by the #1 as well as the #2

and #3- To achieve this we will use

the Lock menu item, the scissors

tool, the Average menu item, and the

Join menu item. The reasons behind

this will be explained later.
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The first step is to select the letter
'A'

and Lock it by selecting Lock

from the Arrange menu, or by typ

ing Command- 1 from the keyboard.

This keeps its shape on the screen

for reference, but prohibits selection

and editing until the object is

unlocked. Zoom in and choose the

Scissors tool and simply click on the

path to cut it in two.

Transform Again XD

Group

Ungroup

XS

XU

Join...

Average..

XJ

XI

Unlock Rll

Hide

Show Rll

Once the path is cut, then select off

of the path to deselect anything that

is selected. Now click while holding
theOption key back on the segment

that was cut away and drag it up.

This can now be deleted away. The

letter
'A'

was not affected because it

was locked.
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Repeat the process for the lower sec

tion of the logo

Move the section away and delete it.
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Now that the
'g'

is cut into sec

tions we want to work on the 'A'.

First we must Unlock it to pro

ceed. Choose Unlock All

(Command-2) from the Arrange

menu. This unlocks the 'A'. Now

we want to lock the 'g' so that we

cannot alter it. Select the 'g' and

Choose Lock (Command- 1) from

the Arrange menu. Zoom in to

get a better view and use the

Scissors tool

the same way

as before to

cut the

paths, where

the
'g'

touch

es the

A'.

tIWtitiiM

Transform Rgain SCO

6roup

Ungroup

386

Join...

Rverage...

XJ

XI

Lock

milHUiHl

Hide

Show Rll

"

XI

WTm

X3 1

384

As before, we can now select and

delete the path that we do not want.

You should now be able to start see

ing the results that we desire.
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Repeat the process for the lower sec

tion of the logo
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Now we have to connect the two sec

tions into one complete path. Unlock

the
'g'

so that we can work with it.

We want to join the points that are

near each other. First we click and

drag the mouse over the points to

select both of them. There might be

a chance they are directly on top of

one another, but that is unlikely.

Once we have selected both points,

we want to Average them.
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The Average dialog box is accessed

by typing Command-1 or choosing
it from the Arrange menu. The

Average option gives the user a

chance to align points on horizontal,

vertical, or both axes. In this case,

we want to

average the

two points on

both axes so

that they are

placed direct

ly on top of

one another.

Transform Again 380

Group

Ungroup

KG

38U

Join... XJ

B_l_mUJ9HSVK2I

Lock

Unlock All

Hide

Show Rll

381

382

383

384

Untitled art I

I Rverage I

Average along
Both oHes

O Horizontal aHis only

OUertical aHis anly

I Cancel 1

While the points are still selected,

we want to now join them. Choose

Join from the Arrange menu, or

type Command-j. The Join dialog
box will appear giving you the

option of a Corner point, or a

Smooth point. In this case, we

would like the Corner point. Click

OK and the points are now joined as

one. If you chooose Join and did not

get the Dialog box, then the points

were not

directly on

top of anoth

er. Undo the

Join and

Average on

both axes

first.

Transform Again 980

Group

Ungrnup

Rverage...

Lack

Unlock Rll

Hide

Show Rll

98G

98U

XI

381

882

983
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Corner point

O Smooth point
| Cancel |
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Untitled art 1

Uniform scale: |25|

Preserve line weights

O Scale line weights

I Cancel |

O Non-uniform scale:

Kortzontfll:

KertKnl:
L IT

D Scale pattern tiles

m

o

Repeat this method for each section.

There should be four joins altogether.

As we see in the example there

should be three separate shapes that

can be moved independently of each

other.

Next Select All Group and Paint

black with no stroke. The reasoning

behind doing this process is the flexi

bility of the logo shape now. We will

continue to work with this logo and

discover its flexibility. Now would

be a good time to save the illustra

tion to disk before we continue any

further.

The next thing we want to do is to

make the logo into a pattern.

Select all three shapes by typing

Command-a, and use the scale tool.

Click with the Option key down in

the center of the logo and the Scale

dialog box will appear. Scale the

logo by 25%, but this time click

Copy. This scales the logo 25%

while maintaining the
original.
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Move the copy off to the side and

paint it 60% black. The example

should show the results so far in

Preview mode.
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To create a pattern in Illustrator you

simply create shapes and place a rect

angle to represent the tiled section

behind the objects. The rectangle or

square can be painted a color or shade

ofblack. In this instance, I we want

a 30% shade of black. Create a rect

angle over the logo and paint it 30%

black. Then send the rectangle to the

back by typing Command - (-).

Select all of the shapes by dragging
the mouse over the objects and

choose Pattern from the Style menu.

Paint...

Type...

381
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ag logo

! Pattern I

Change name to:

small R6

I Cancel]

Q_euT_l

("Delete |

("Paste |

2 [Select fill Unused I

EE

Once Pattern is selected from the

Style menu, the Pattern dialog box

appears. Choose New and the pattern

will appear in the lower right with

the default name Pattern 1. Name

the pattern appropriately and select

OK. Now that a pattern is created,

we want to use the same items to cre

ate a lighter version of the same pat

tern. To do this, simply select the

individual items and paint them

lighter shades. The logo was 60%

black, make it 40% black now. The

back rectangle was 30% black, make

it 15% black.

Preview will show the new pattern as

a lighter shade than the previous pat

tern made.
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Select the shapes as before and

select Pattern from the Style menu.

You should be presented with the

Pattern dialog box with the pre

viously placed pattern. Click New

and name this pattern "light small

AG". Now we have two identical

patterns that are ofdifferent shades.

These patterns will be instrumental

in creating an effective drop shadow

on a patterned back ground.
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Pattern i

(Caneel 1
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| Oelete |

("Paste |

| (Select All Unused |

Change name to:

light small RG ]
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Delete the shapes that were used as

to create the patterns. They have no

more use to us. Draw a large square

to frame our logo. Send it to the

back. Type Command-I for paint.
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Paint

I Transform Pattern Style I

rMove
1

Distance: |0

Direction:
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|P.

O Rngled: 1

Scale

Uniform

O Non-Uniform
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Lii1l<ol:

I Cancel |
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|~
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The Paint dialog box appears with a

new addition. The Pattern option is

available now. Click that option to

paint the square with the new pat

tern. We do not want the pattern to

be as Large as we created it. We have

the option to do many things to it by

using the Transform
button. Click

that button and an additional dialog

box appears.

All we want to do is scale the pattern

down by 50%. Type 50 into the box

for Scale. There are many other

options that are useful.

Experimentation will be fun and

educational to see the possibilities.

Click OK on this Dialog and the

Paint Dialog boxes.
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We should see the results shown in

the example. Now we want to create

a believable drop shadow.

Select the logo and hold the Option

key down while you drag the mouse

up and to the right. This makes a

copy of the logo. Remember that

the copy of the logo is on top of the

original. Select the original logo to

paint it. The original logo is now

the drop shadow. We want to paint

it with the other pattern. Also we

want to put a two point stroke on

the frame.
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ag logo

Paint

Transform Pattern Stgle I

Direction:

Horizontal

O Uertical

O Rngled: [

r-Scale 1

Uniform |EEaHl%

O Non-Uniform

Horizontal: f \l.

Uaillral: f ]a

I Cancel |

Rntate angle: lo

Reflect across

None

O Horizontal
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O Angled:

f"

]*
rShear

Angle:

RhIs:
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O Uertical

O Rngled:

?
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Select the darker pattern -"small

AG"

and select the Transfrom option. We

want to scale this pattern to 50% to

match the other pattern. Click OK

for both Dialog boxes.

We now see that the drop shadow is

more realistic due to the fact that it

is a darker shade of the other pat

tern. This technique can be used to

put together anything you can think

up.
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Trouble-

Shooting,

Useful Tips

& Special

Effects

When working with these letter

forms, remember that they are not

regular Macintosh type, but actual

artwork. They need to be treated as

such so that destruction of the type

face does not occur. Illustrator's

Undo feature is not very reliable. If

you make a mistake, you must catch

it immediately or the Undo will not

work. When moving, copying,

slanting, rotating, or coloring the

letters, special consideration must be

taken to get the results you want.

Everyday I work with these letter

forms, I make the same mistakes

over and over again.

The example below shows what

happens when a letter is movedwith-

out all of the points and paths select

ed. Remember that Illustrator lets

you move around or alter paths by

selecting the paths and dragging

them around. To move a letter, all of

the paths and points need to be

selected. The problem is easily solved

by holding the Option-key while

selecting the path. This selects all of

the paths and associated points. If

you were to make a mistake as in the

example below, Undo the mistake

right away. If any other operation is

performed, the Undo is null and

void. Even a simple click of the

mouse will disable the Undo feature.
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When selecting letters to copy,

move, or alter in anyway, make sure

that you include any counters that

belong to the letter. These counters

are separate shapes and should be

treated that way. We see in the

example that the counter or the

'R'
was left behind.
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To select multiple letters, you can

click on the letter with the Option

key held and click on the next letter

with the Shift key and Option key
held. A simpler way to do this is to

drag the mouse over letters to select

them. In the example, the Option

key was not held, so the
'S' letter

was not completely selected.
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Dragging the mouse over many let

ters is a much quicker way to select

many letters at one time. If the

Option key is held down at the same

time, whatever path the dashed line

crosses, all of the paths and points

associated with it will be selected.

This method speeds up work and

makes time spent at the computer

more productive.
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A common mistake is made all the

time when drawing a straight line to

a curve line. Most people forget to

give the straight line a curve-to point

so that the curve is smooth from the

straight line rather that bent offof it.

The differences are illustrated to the

left with 10 point lines. Notice the

difference to the lines where they

start the curve.
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The stroke controls for joins of two

paths gives you the ability to alter

the way two paths come together.

The three examples to the right

show a 40 point stroked line with

the three different joins. The first

join is the default, The next join is

for smooth joins, and is useful for

neon type effects discussed later. The

last is the beveled join. They all

have their own particular uses.
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The line cap feature lets you con

trol how the stroke will end.

Stroked paths get larger or grow

from the center; therefore a ten

point stroke will have five points

ofwidth on either side of the path.

On the first stroke, the cap ends at

the end of the path. The second

stroke is capped by a circular ends

whose radius is 1/2 of the point

size. The third stroke extends the

stroke 1/2 the point size beyond

the end of the path.
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A major problem can occur when

using traced typefaces. That prob

lem comes when a shape is placed

behind a letter that contains a

counter. The counter is not a hol

low shape punching out the letter

but a solid shape that is only a dif

ferent color than the letter. There

are several ways to correct this

problem. If the shape behind the

letter is a solid color and complete

ly covers the counter area, the prob

lem can be solved simply by

coloring the counter to match the

back ground. However, if the back

ground is complex, then other mea

sures need to be taken.
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We need to make the letter and

counter one continues path or

shape. We achieve that by cutting,

joining, and realigning the paths of

the letter and its counter. Use the

scissors tool to cut the paths. Click

on the paths with the scissors tool

as seen in the example.
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Select the cut point on each path and

drag it to the right. This will sepa

rate the paths so that they are not

directly on top of one another.

Select a point from the letter and

the corresponding point of
the

counter and join them by choosing

Join from the Arrange menu or

by typing Command-j from the key

board. This draws a lie between the

two points. We now have a continu

ous shaped letter that has a true

counter that enables objects to be

seen from behind.
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Now we need to close up the space

that was created when we separated

the paths. Select all of the points

and average them by choosing
Average from the Arrange menu or

type Command -L.

Select Vertical axis only so that the

points align. The shape is complete.
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Select the shape and in Paint mode,

choose Black for Fill. In Preview

mode, we see now that the shape has

a "true
counter"

that lets anything

behind it show through.
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The problem with this letter now is

that the stroked form of the letter

now has an ugly line going through

it. While some of these types ofprob

lems are easily avoidable, others

require a little creativity to overcome.

To fix the problem ofwanting a filled

letterwith a different colored stroke,

you can use a white "true
counter"

letter with the original uncut letter

that has no fill and a black stroke on

top, then the problem will be solved

with a little work.
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Using the Blend Tool

Very nice special effects can be

achieved by using the Blend tool.

We can easily make neon type, zoom

type, and great shape changes that

has endless possibilities. To demon

strate these effects, I will make the

'X'

neon, the 'V zoom text, and the

'Z'
change shape to a square. All of

these effects make use of the Blend

tool. To follow along, use any letter

forms you have available. For these

examples I will be using Laser.
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For the neon example, use a letter

that contains no counters. The reason

for this is that for each shape, coun

ters and outlines, we will need a sep

arate blend. Start with a 5 point

stroked letterwith no fill. Select the

letter while holding the Option key
and drag a copy just a little to the

side of the original.

iDl II 1 ^^^= Untitled art 1 ^^^ ~r01

o

-
.1

Q>
;t..

T

iS* "i
'

'
!

-

to T

CD .i.

O -r

Ki

3

CV

m i
D-y yy\
>
s/s ^7P J / '-\--

M "^ ^^ / /
Ds 1 \j^ / 1 o

01,,-:!,": XT
;..,.:..,:,...

| ,|C>a

95



Zoom in as close to the letter as pos

sible. Select the copied letter and

change its paint from a large black

stroke to a small white .5
stroke.

The example shows the results so far.

96



This is perhaps the most important

step to get correct. To blend shapes

in Illustrator, you need to select an

origin point on the first shape and a

corresponding point on the end

shape. Select the two points that are

near each other. Then with the

Blend tool click on the first point

and then the second. Once the sec

ond point is selected, a dialog box

should appear.

The Dialog box gives you the chance

to enter how many steps in between

the first and last you want to blend.
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The Preview shows the blend results.

The concept behind neon type is

blending a large black stroke to a

small lighter stroke. The same effect

works with color. The number of

steps will determine how smooth the

neon effect will appear. Experiment

with different colors to get a variety

of interesting effects.

The zoom type effect uses the same

concept. Start with a black filled, no

stroked letter.
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Scale a copy down to 80% of the

original. Move the copy off to the

side and send it to the back by typ

ing Command- (-).

Paint the copy a lighter shade of

gray and Preview the results to see

if they are similar to the example.
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As we did in the neon example,

select two corresponding points on

both shapes. Use the Blend tool to

click on both of the selected points

to gain access to the Blend Dialog

box. Enter number around 20 to 30.

The blend will take place.

The results are shown to the left.

Placement of the copy will determine

the look of the zoom. Once again,

colors can be used and the number of

blends will determine how smooth

the zoom will look.
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This next effect will show how the

blend tool can blend two totally dif

ferent shapes. For this example I

will blend the 'Z' letter to a rectan

gle. I drew a rectangle away from

the
'Z'

and painted the rectangle

black. The 'Z' is painted 50% gray.

As we did in the previous examples,

select the two shapes and use the

Blend tool to choose points on the

two shapes.

I am sure you have seen thisWarning

dialog box every time you used the

blend tool. What happened to get

this Dialog box is that I tried to

blend the 'Z' letter to a GROUPED

rectangle. When you use the

Rectangle tool and the Ellipse tool,

the shapes drawn are always grouped

paths. You MUST ungroup the shape

in order to use the Blend tool on it.

The Dialog box says to use the Blend

tool on a selected endpoint ofan

ungrouped open path. The path does not

have to be open but if it is then you

must click the Blend tool on an end-

point of that path and not a point in

the middle.
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Ungroup the rectangle and try the

blend again. The example to the left

shows a blend of 8 steps. The points

on the paths you select will deter

mine greatly how well the blend will

come out. Experimentation will

yield the best results. On the follow

ing page I will show how the selec

tion ofpoints on two objects makes

a big difference in the outcome of

the blend.

The preview shows the power of the

Blend tool. Its uses are left only to

the imagination. Remember that

the Blend tool will blend strokes

and fills. If you were to blend a let

ter that has red 10 point stroke and

a yellow fill with a letter that has a

black one point stroke and a green

fill, all of the sizes, weights, shape

and colors will be blended.
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In this example, I created four rect

angles and ungrouped them. I

placed them on the left side of the

screen them copied them to the

right side. Then I produced blends

between the rectangle on the left

with the rectangle on the right. The

numbers indicate the points that I

chose on the first (left) and last

(right) shapes. As you see, the

results can be quit unique or not

at all what you expected.

The same process was carried out

blending rectangles to circles. The

results speak for themselves.

i Untitled art I

to
CD

O

3

a

Hi

M

D

m n He

103



Masking

In this example, we will blend

strokes ofdifferent weights and

mask the results inside the Tabasco

ampersand. Paint the shape with

None for Fill, Black for Stroke and a

line weight of 0.5.
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Start by drawing a line near the top
of the letter that covers thae width of

the letter. Copy the line and place it

as seen in the example. Stroke the top

line at a weight of one point. Make

sure there is also no fill. Stroke the

bottom line to a weight often points.
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The example shows the Preview of

the results so far.

Now we want to blend the lines.

Select the end points ofboth paths. If

the lines contained more than two

points the Blend tool would display

aWarning ifanything but the
end-

points were selected.
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Select the the Blend tool and click

the endpoints as shown in the exam

ple. Enter an amount of 12 steps.

m

Untitled art 2

15

"""-:

QBE m
o

a

In Preview mode, the results show

a progression of line weight

changes that produce a very nice

effect. We now want the lines to

draw only inside the boundaries of

the ampersand. This is achieved by

using the masking feasture.

STP in, m Untitled art 7 SPll

It

T

lr*

to
CD

O

...
'

|

/ :;i

s
bbbbbbbbbSbbbiZbbiIbbZ

bbbbbbbbbbbbbbbbbbbbbbbZ

it

^^^BBBBBBBB^^^^S?

3

cv

Hi

uJT

>e

M

D

^^^^

^

mmWmm^MmmmMMMMMMMMMMMmMMMWMMM^MMm

o

QBii&Mi '!;!:* ; i ^ 1
!

i 'H 1; ':: U. ;..i.-..i., M M--..4 | |0a

106



0-
mask

I Paint I

-Fill

None

OWhite

O Black

O Process Color

O Custom Color

O Pattern

.-Stroke

^
,
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Black bbbbbbbbbI

O Precess Color
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To set up the shape to be a mask,

simply select the shape and
paint it.

The mask feature is found in the

Paint dialog box. Click the box

beside the word mask and click Ok .

The results are shown in the example.

The way the mask works is that any

thing that is on top or in front ofa

shape that is designated as amask

will draw inside of that shape. The

mask must be a closed shape. It also

must be an ungrouped shape or the

mask will not work.
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Let's say we want to put another

shape in to the illustration. Draw a

circle that does not fall within the

boundaries of the ampersand. Make

sure that the color is painted black.
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In the Preview mode we see that

the circle is not showing. The rea

son for this is the circle is not with

in the boundaries of the ampersand.

To let the circle draw, we must

group the lines to the mask in this

case, the ampersand.
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When making masks, after the mask

looks as desired on the screen, you

should group the things being
masked (the lines) to the mask object

(the ampersand). This now lets the

circle draw or show on the screen.

The circle is not a part of the mask

and now is not associated with it.
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The Preview shows that the circle

will now indeed show. The thing to

remember when you setting up masks

is that anything on the page, whether

within the shape or not is associated

with that mask. The grouping of

objects to a mask lets Illustrator know

which objects are to be masked to the

shape and which are not.
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Conclusion I hope this manual has provided

some helpful ways to use Adobe

Illustrator, in ways that make you

more productive, your designs

stronger and crisper, and your time

more valuable. Most of all, it should

show you that almost anything once

drawn by hand, can be easily drawn on

the computer.

With all of the recent advances

with programs that convert Adobe

fonts to outline form, such as

TypeStyler and other font conver

sion utilities, designers will have end

less amounts ofoutlined fonts to

design with and alter. These same out

line fonts can also easily be visually

destroyed if proper care is not taken

when working with them.

One final note, ifyou can trace an

entire typeface and make it look good,

then anything that you scan will be

much easier to trace in Illustrator.
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\^/OXlA|3AdC The following pages contain the forty
eight different fonts that I drew dur-

nrVr-g-%^T^|dT*C ing the work on this thesis. I chose

J MT the following fonts because of their

uniqueness and flexibility. Each font

was scanned from a specimen book

and drawn in Illustrator.
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'\7Jl'f*1fYI'1C |.jf")Qrf)^ The following pages contain various

^9 logos design using the drawn type
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faces. There are also various projects

17M.vflvvW that were created during the writing
of this thesis.
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1 Squared line joints.

2 Rounded line joints.

^ Beveled line joints.

WWKWM4R7:



First select a letter to make neon. T
A

2
Next, change the stroke to black and
the point size to anywhere from

3 to 5 points. Also make sure the

fill is set to none.

3
Make a copy of the letter offset slightly
from the original. Set the stroke point size

to .5 and the color to white. Now you have

a large stroke letter with a smaller stroked

white letter on top.

4
Now select two corresponding points

on both letters and blend between

them in 5 to 10 steps. The more steps

achieves a smoother gradient.
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